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INTRODUCTION
Overview

This is an installation and configuration guide for the Endpoint Concentrator VE
in a network using vSphere Client v4.x or v5.x.

Note: Stealthwatch VE appliances that are running under VMware ESX v3.x are not
compatible with ESX v4.x. If you upgrade VMware to ESX v4.x, youmust delete your
existing Stealthwatch VE appliances and reinstall them.

Read this chapter to learn more about this guide and how to contact Support, if
needed. This chapter includes the following sections:

l Audience
l About Endpoint License
l Before You Begin
l Admin Home Page Usage
l How to Use This Guide
l Resource Requirements

Audience
The primary audience for this guide is administrators who need to install and
configure Endpoint Concentrator VE. This guide assumes the audience has a basic
familiarity with VMware software.

About Endpoint License
The Cisco Stealthwatch Endpoint License solution enhances the network visibility
provided by the Cisco Stealthwatch System with endpoint data provided by the
Cisco AnyConnect Network Visibility Module. The figure below provides a high
level overview of the Stealthwatch Endpoint License solution and its components.

© 2016Cisco Systems, Inc. AllRightsReserved.
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AnyConnect with NVM: The Cisco AnyConnect NVM installed on network
attached endpoints sending nvzFlow records to the Stealthwatch Endpoint
Concentrator

Stealthwatch Endpoint Concentrator: A purpose built appliance that will receive
nvzFlow records from multiple endpoints and forward endpoint flow records to the
Stealthwatch Flow Collector. The Stealthwatch Endpoint Concentrator will appear
as a single exporter to the Stealthwatch System and is a required component of
the Endpoint License.

Stealthwatch Flow Collector: Serves as a central collector for flow data
generated by NetFlow-enabled devices. The Stealthwatch Flow Collector monitors,
categorizes, and analyzes network traffic to create comprehensive security
intelligence at both the network and host level.

Stealthwatch Management Console: Manages, coordinates, and configures all
Stealthwatch appliances to correlate security and network intelligence across the
enterprise.

The Stealthwatch Endpoint License solution enables the Flow Collector to extract
endpoint specific fields from the flow records forwarded to it by the Endpoint
Concentrator and through its process of stitching and de-duplication insert the
endpoint fields into the conversational flow record maintained in the Flow
Collector database. In the initial release the following fields will be attributed to
flows where the host with the AnyConnect NVM is the initiator of the flow:

l Process name
l Process hash
l Process account
l Parent process name
l Parent process hash

Introduction
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Note: It is important to note that in the initial release of the Stealthwatch Endpoint License
it is necessary that the Stealthwatch Flow Collector receive corresponding flow records
from a network device

Before You Begin
Use the information in this section to prepare for installing and configuring the
Stealthwatch VE appliances. Note that the configuration is a two-part process
using first the vSphere client interface, and then the Appliance Administration
(Admin) interface. You can use the tables provided in this section to record
settings you will need to install and configure the Stealthwatch VE appliances.

As an add-on licensed feature to the Stealthwatch System, before beginning the
setup of the Stealthwatch Endpoint License you will first need to install and
configure the Stealthwatch System. Once this is complete you may proceed with
the installation and configuration of the Endpoint License Concentrator. If you do
not have a fully operational Stealthwatch deployment before the deployment of the
Endpoint Concentrator your Stealthwatch deployment may not be able to
effectively collect endpoint data.

You need to install and configure these Endpoint components in the following
order:

1. Flow Collector
2. Endpoint Concentrator
3. Agent

If you do not follow this recommended order when you set up the Stealthwatch
system, the Stealthwatch System may not properly collect data from the
appliances and you will have to set up each one separately.

CAUTION! Be sure the time setting on the ESX server where you will be installing the
virtual appliances reflect the correct time. Otherwise, the appliances may not be able to
boot up.

Downloading the VE Software
Before you can complete the procedures in this guide, you must obtain the OVF
(Open Virtualization Format) file from the Download and Licensing Center. For
instructions on downloading the file for each appliance, see the Downloading and
Licensing Stealthwatch Products document in the Download and Licensing Center
or in the Documentation Library found in Help of the Stealthwatch appliances.
Cisco AnyConnect configuration guides are at the Cisco web site.

Introduction
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Resource Requirements
This section provides the resource requirements for the Endpoint Concentrator.

Endpoint Concentrator

These are the requirements for the Endpoint Concentrator VE 1000:

Reserved CPU Reserved Memory Maximum FPS Rate
2 8GB 20,000

Note: The capacity of your Flow Collector should be taken into consideration in
determining the number of endpoint concentrators needed for your deployment.

Information Needed for the vSphere Client Interface

Setting ESX/vSphere
Server Endpoint Concentrator VE

Login User Name

Login Password

IP Address (Default = 192.168.1.x)

Netmask IP Address (Default = 255.255.255.0)

Gateway IP Address (Default = 192.168.1.1)

Information Needed for the Appliance Admin Interface

Setting Endpoint Concentrator VE
IP Address (Default = 192.168.1.x)

Host Name

Network Domain Name

NTP Server IP Address(es)

DNS Server IP Address(es)

Introduction
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Admin HomePage Usage
For this release you need to understand the Home page of the Endpoint Concentrator
VE Admin interface. The current Help pages do not reflect the correction information
needed. Use this section to understand how the.

The Home page, which is refreshed every minute, displays statistics about the
appliances in the following sections. You can also use this page to perform certain
administrative tasks, such as restarting or stopping processes that are running on the
appliance. It includes several sections, which are described below.

System
Use this section to find information about the appliance, such as the IP address, host
name, version, or serial number.

The following table provides the field descriptions for the System:

Field Description

Build An alphanumeric code that identifies the build version of the appliance.

Domain Name The domain name that is assigned to the appliance.

FreeMemory The amount of memory that is currently available for use.

Load Average A measure of the average system load over the past one-, five-, and
fifteen-minute periods, respectively.

Platform The virtual platform on which the appliance software is installed.

Serial No. The serial number or ID of the appliance. You need the serial number to
activate the license for the appliance.

Introduction
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Field Description

Total Memory The total amount of memory installed on the appliance.

Uptime The amount of time since the appliance was last rebooted.

Version The version of the software that is installed on the appliance.

Endpoint Status
The Endpoint Status section indicates the amount of flow data of the NetFlow Parser
and the NetFlow Generator that this appliance has collected or dropped every minute
and over the course of the day and the number of UDP packets received.

The following tables provide the field descriptions for Endpoint Status:

NetFlow Parser Description
Service Running An icon that indicates if the service is running: green check-

mark if running, red dash if not.

Packets Received UDP Packets the service has received from exporters.

FPS (Flow Rate) The average rate at which flows have been processed by the
appliance in the corresponding time period.

Data Sets Dropped The total number of flows that were lost, usually due to network
congestion, in the corresponding time period.

Placed in Queue Records placed on a queue for the next service (Netflow-Gen-
erator) to receive.

NetFlow Parser

Service Running An icon that indicates if the service is running: green checkmark if
running, red dash if not

Packets Received UDP Packets the service has received from exporters.

FPS (Flow Rate) The average rate at which flows have been processed by the appli-
ance in the corresponding time period.

Data Sets Dropped The total number of flows that were lost, usually due to network
congestion, in the corresponding time period.

Placed in Queue Records placed on a queue for the next service (Netflow-Gen-
erator) to receive.

Introduction
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NetFlow Generator

Service Running An icon that indicates if the service is running: green checkmark if
running, red dash if not

Received from Queue Number of messages received from exporters for each period.

Dropped Data The total number of flows that were dropped, usually due to net-
work congestion, for each period.

Parsed Data Number of flows processed from received messages for each
period

Packets Sent Number of UDP packets forwarded to the Flow Collector for each
period.

NetFlow Generator Description
Service Running An icon that indicates if the service is running: green check-

mark if running, red dash if not.

Received from Queue Number of messages received from exporters for each period.

Dropped Data The total number of flows that were dropped, usually due to net-
work congestion, for each period.

Parsed Data Number of flows processed from receivedmessages for each
period

Packets Sent Number of UDP packets forwarded to the Flow Collector for
each period.

Services
The Services section displays the status of the processes that are running on this
appliance and how much memory they are using.

The following table provides the field descriptions for Services:

Field Description
Name The name of each service

Status The current status of the corresponding service

Introduction
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Field Description

PID The process identifier of the corresponding service

Started The amount of time that the corresponding service has been running. If
it has been less than 24 hours, the amount of time is shown. If it has
beenmore than 24 hours, the date that the service started is shown.

CPU Usage The percentage of the CPU's (central processing unit) total capacity
that is being used by the corresponding service.

Memory Usage The percentage of the appliance's total memory that is being used by
the corresponding service.

Action You should only stop or restart a service at the direction of Customer
Support. If you restart a service that is running, theremay be a short
period in which data is not captured.

This column contains buttons that allow you tomanually execute
actions for the corresponding service. The following actions may be
available:

l Stop
l Start
l Restart

Docker Services
The Docker Services section displays the status of the Docker processes that are
running on this appliance.

The following table provides the field descriptions for Docker Services:

Field Description
Name The name of each service:

l Zookeeper is a centralized service for maintaining con-
figuration information, naming, providing distributed syn-
chronization, and providing group services.

Introduction
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Field Description
l Kafka is a distributed, partitioned, replicated commit log ser-
vice that provides the functionality of a messaging system.

l NetFlow Parser is a service that receives and forwards end-
point messages to the NetFlow Generator.

l NetFlow Generator is a service that forwards endpoint flows to
the Flow Collector or the UDP Director.

Status The current status of the corresponding service.

Started The amount of time that the corresponding service has been running. If
it has been less than 24 hours, the amount of time is shown. If it has
beenmore than 24 hours, the date that the service started is shown.

Action You should only stop or restart a service at the direction of Customer
Support. If you restart a service that is running, theremay be a short
period in which data is not captured and all logged in users will need
to re-authenticate.

This column contains buttons that allow you tomanually execute
actions for the corresponding service. The following actions may be
available:

l Restart
l Stop

Network Interfaces
The Network Interfaces section displays the data for the hardware interfaces on the
appliance.

The following table provides the field descriptions for Network Interfaces:

Field Description

Name The text identifier for the interface.

Up The state of the interface, as follows:

l True – Enabled
l False – Disabled

Introduction
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Field Description

IP Address The IP address associated with the interface. Only themanagement
port (eth0) will show an IP address.

MAC Address TheMAC address associated with the interface.

Auto Neg The state of the auto-negotiation setting, either:

l True – The setting is On.
l False – The setting is Off.

Link Speed (bps) The speed at which the interface is sending and receiving data.

Duplex The duplex setting for the interface, either:

l Full – for Full Duplex
l Half – for Half Duplex

MTU Themaximum packet size the interface is allowed to transmit per
transaction.

RX Statistics for the received data according to the following
characteristics:

l Bytes – The amount of undamaged data received, in bytes.
l Packets – The amount of undamaged data received, in pack-
ets.

l Errors – The number of damaged packets in the received data.
l Dropped – The number of dropped packets in the received
data.

TX Statistics for the transmitted data according to the following
characteristics:

l Bytes – The amount of undamaged data transmitted, in bytes.
l Packets – The amount of undamaged data transmitted, in pack-
ets.

l Errors – The number of damaged packets in the transmitted
data.

l Dropped – The number of dropped packets in the transmitted
data.

Action Includes an Edit link to the Network Interface Configuration page that
allows you tomanually configure the interface.

Disk Usage
The Disk Usage section displays information about the hard drive space on this
appliance.

Introduction
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The following table provides the field descriptions for Disk Usage:

Field Description

Name The location in the appliance's directory structure where the
corresponding data exists.

Used The amount of available space (in percentage) occupied by the
corresponding data. When the percentage reaches 75%, the row turns
red. If this occurs the data is dropped. You can prevent this from
happening by expanding the virtual disk space.

Size (byte) The amount of space (in bytes) allocated for the corresponding data.

Used (byte) The amount of space (in bytes) occupied by the corresponding data.

Available (byte) The amount of unused space (in bytes) for the corresponding data.

How to Use This Guide
In addition to this introduction, we have divided this guide into the following
chapters:

Chapter Description
Installing a Virtual Appliance How to install the Endpoint Concentrator on an ESX

server using vSphere Client v4.x or v5.x

Configuring the Virtual Environment How to set up the virtual environment for the Endpoint
Concentrator

Configuring a Virtual Appliance System How to configure the Endpoint Concentrator to begin
processing traffic data

Abbreviations
The following abbreviations appear in this guide:

Introduction
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Abbreviations Definition
DNS Domain Name System (Service or Server)

dvPort Distributed Virtual Port

ESX Enterprise Server X

GB Gigabyte

IDS Intrusion Detection System

IPS Intrusion Prevention System

IT Information Technology

MTU Maximum Transmission Unit

NTP Network Time Protocol

OVF Open Virtualization Format

SMC Stealthwatch Management Console

TB Terabyte

UUID Universally Unique Identifier

VDS vNetwork Distributed Switch

VE Virtual Edition

VLAN Virtual Local Area Network

VM Virtual Machine

Other Resources
In addition to this guide, you may find these documents and online resources useful.

Related Documents
Please refer to your Stealthwatch Documentation for information about
Stealthwatch appliances and their installation and configuration. Please see Cisco
Stealthwatch online at for information about Stealthwatch products.

You can also open the Documentation Library from one of the following links:

l On the SMC Web App interface, click the Help button and select Documentation
Library,

l In the main menu of the SMC client interface, click Help > Documentation.
l In the main menu of the Appliance Admin interface, click Help > Docu-
mentation Library.

Introduction
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Additional information is available in the Lancope Community web site
(community.lancope.com/). If you do not have login access to the web site, send an
email requesting access to Support.

Lancope Blog
Lancope’s Inside the Threat blog at http://www.lancope.com/blog/ provides a wealth
of information about NetFlow, the NetFlow industry, and new Stealthwatch
features, as well as tips and tricks on using Stealthwatch.

Lancope Resources & Tools for Advanced Cybersecurity
For further information about Stealthwatch, go to the Lancope Resources & Tools
for Advanced Cybersecurity site https://www.lancope.com/resources. It includes
resources such as an online video library, white papers, and Webinars.

Contacting Support
If you need technical support, please do one of the following:

l Contact your local Lancope partner.
l Call +1 800-838-6574.
l Submit a case using the Support form on the Lancope Customer Community web
site (community.lancope.com)

Document Feedback
If you have comments about this document, please contact Lancope at
support@lancope.com. We appreciate your feedback.

Introduction
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2

INSTALLING THE ENDPOINT
CONCENTRATOR VE
Overview

This chapter describes how to install the Endpoint Concentrator VE using
VMware vSphere Client v4.x or v5.x.

Note: Make sure the time set on the ESX server where you will be installing the virtual
appliance reflects the correct time. Otherwise, the virtual appliances may not be able to
boot up.

CAUTION! Do not install VMware Tools on a Stealthwatch virtual appliance because it will
override the custom version already installed. Doing so would render the virtual appliance
inoperable and require reinstallation.

Process Overview
Installing a virtual appliance involves completing the following procedures, which
we discuss in this chapter:

1. Configuring Your Firewall for Communications
2. Logging in to the VMware vSphere Client
3. Adding a Resource Pool
4. Installing the Endpoint Concentrator VE

Configuring Your Firewall for
Communications

In order for the appliances to communicate properly, you should configure the
network so that firewalls or access control lists do not block the required
connections. Use shown in this section to configure your network so that the
appliances can communicate through the network.

© 2016Cisco Systems, Inc. AllRightsReserved.
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Use the port information in this section to configure your network so the appliances can
communicate on through the network:

l TCP 22
l TCP 443
l UDP 53
l UDP 123
l UDP 161
l UDP 162
l UDP 514
l UDP 2055
l UDP 3514

Communication Ports
The following table shows the ports needed for Endpoint Concentrator
communications:

From (Client) To (Server) Port Protocol

Admin User PC All appliances TCP/443 HTTPS

All appliances Network time
source UDP/123 NTP

AnyConnect Endpoint Con-
centrator UDP/2055* NetFlow

Endpoint Con-
centrator

Flow Collector
NetFlow UDP/2055* NetFlow

Endpoint
Concentrator UDP Director UDP/2055* NetFlow

* These ports are configurable.

Logging in to the VMware vSphere Client
To install the virtual appliance, you must first log in to the VMware vSphere
Client, by completing the following steps:

Installing the Endpoint Concentrator VE
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Note: The screen images are for VMWare v5.0 andmay appear slightly different from your
screens, but the commands are the same.If you use the VMwareWebClient v5.5
interface, some of the screens shown here will differ. Therefore, the differences in the
options chosen will be pointed out where necessary.

1. Launch the VMware vSphere Client software. The Login dialog opens.

2. Type the IP address of the ESX server and your login credentials, and then
click Login. The Home page opens.

Note: TheWebClient has two dialogs for the configuration: Select name and location and
Configure settings.

Adding a Resource Pool
A virtual appliance needs a resource pool with specific CPU and memory resources
allocated to it so that it can operate without affecting other virtual machines. This
procedure describes how to add a new resource pool with the proper allocations for
the Endpoint Concentrator VE.

Note: If desired, you can use an existing resource pool for a virtual appliance. However,
you should examine this procedure tomake sure the existing resource pool has enough
resources allocated to it for a virtual appliance to operate properly. If you use the VMware
WebClient v5.5 interface, some of the screens shown here will differ. Therefore, the
differences in the options will be pointed out where necessary.

To add a resource pool for a virtual appliance on the ESX server where it will
reside, complete the following steps:

Installing the Endpoint Concentrator VE
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1. In the Inventory tree on the left, right-click the ESX server IP address, and
then select New Resource Pool from the popup menu or on the Web client
select All vCenter Actions > New Resources Pool..

The Create Resource Pool dialog opens.

2. In the Name field, type the name you want to use to identify this resource
group.

3. Do not change any of the settings in the CPU Resources section.
4. In the Memory Resources section, do the following:

Installing the Endpoint Concentrator VE
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l Change the Reservation field as recommended in the chart for the appliance
in “Resource Requirements” on page 4.

l Click the Unlimited checkbox to clear it.

7. Click OK. The resource pool appears beneath the ESX server on the Inventory
tree.

8. Select the resource pool, and then click the Resource Allocation tab to review
the CPU and memory resource allocations. On the Web Client, click the Man-
age tab and then click CPU Resources & Memory Resource.

Installing the Endpoint Concentrator VE
To install the Endpoint Concentrator VE on the ESX server and define the virtual
appliance management and monitoring ports, complete the following steps:

1. Unzip the virtual appliance software (OVF) file that you downloaded earlier.
2. On the vSphere client menu, click File > Deploy OVF Template. On the Web

client, right-click the host, and then select Deploy OVF Template.

Installing the Endpoint Concentrator VE
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Note: TheWeb client OVF template wizard has slightly different wording and numbering
for the steps of the procedure, but the steps are the same. One example is theWeb client
uses Source Location instead of Source. The image below shows the steps on the left side
for a OVF template ready to deploy:

The Deploy OVF Template wizard opens.

Installing the Endpoint Concentrator VE
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3. Click Browse, and then navigate to select the virtual appliance OVF file.
4. Click Next to display the OVF Template Details page (Web Client: 1.b. Review

details).

Installing the Endpoint Concentrator VE
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5. Click Next. The End User License Agreement opens (1c. Accept EULAs).

Installing the Endpoint Concentrator VE
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6. After reviewing the information, click Accept, and then click Next. The Name
and Location page opens (2a. Select name and folder).

7. If desired, change the name for the virtual appliance as it will appear in the
Inventory tree, and then click Next.

l If the Specify a Specific Host page opens, select the host or cluster where the
virtual appliance will reside.

Installing the Endpoint Concentrator VE
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l If the Host/Cluster page opens, select the host or cluster where the appli-
ance will reside.

8. Click Next. The Resource Pool page opens.

Installing the Endpoint Concentrator VE
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9. Select the resource pool that you defined earlier, and then click Next.

a. If the Datastore page opens, go to step 10.

b. If the Disk Format page opens, go to step 11.

Note: On theWebClient the Select storage page opens and includes both the datastore
and the disk format.

10. On the Datastore page, select where you want to store the virtual appliance,
and then click Next.

Installing the Endpoint Concentrator VE

© 2016Cisco Systems, Inc. AllRightsReserved.

25



The Disk Format page opens.

Installing the Endpoint Concentrator VE
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Note: The vSphere Client v5 has two thick-provisioned formats: Lazy Zeroed and Eager
Zeroed. Choose the one that best suits your disk storage needs. Use the Thin Provision format
only if your disk space is limited. For further information, refer to your VMware documentation.

11. On the Disk Format page, select Thick provisioned format, and then click
Next. The Network Mapping page (Web Client: 2c. Setup Networks) opens.

12. From the Destination Networks drop-down list, select a virtual appliance
management port.

13. Click Next. The Ready to Complete page opens with a summary of the settings.

Installing the Endpoint Concentrator VE
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14. After reviewing the settings, click Finish. A progress dialog opens.

15. When the deployment is completed, click Close to close the progress dialog. The
virtual appliance appears in the Inventory tree.

16. Continue with the next chapter, Configuring the Virtual Environment

Installing the Endpoint Concentrator VE
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3

CONFIGURING THE VIRTUAL
ENVIRONMENT
Overview

After you install the Endpoint Concentrator VE, you are ready to configure the
virtual environment for them. This process involves completing the following
procedures as detailed in this chapter:

1. Configure the IP Addresses
2. Change the Default User Passwords

Configure the IP Addresses
To configure the IP addresses for Endpoint Concentrator VE, complete the
following steps:

1. If necessary, launch the vSphere Client software and log in. The Getting
Started page opens.

2. In the Inventory tree, select the Endpoint Concentrator.
3. On the Getting Started page, click the “Power on the virtual machine” link. You

may need to scroll down to see the link.

Note: If the virtual machine does not power on and you receive an error message about
insufficient available memory, do one of the following:

l Increase the memory reservation limit for the appliance and its resource pool.

l Increase the available resources on the system where the appliance is installed.

4. Click the Console tab. (On the Web client, click the Summary tab and then
click the Launch Console link.) Allow the virtual appliance to finish booting up.
The Administrative IP Address page opens.

© 2016Cisco Systems, Inc. AllRightsReserved.
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Note: Youmay need to enable the Full ScreenMode (Ctrl+Alt+Enter) to view the entire screen.

5. Click on the page, and then enter the IP address for the Endpoint Concentrator.
6. Select OK, and then press Enter. The IP Netmask page opens with the default

network mask IP address.

7. Do the following:

l Accept the default value or enter a new one based on your environment.
l Select OK and press Enter to continue.

The IP Broadcast Address page opens with the default broadcast IP address.

Configuring the Virtual Environment
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8. Do the following:

l Accept the default value or enter a new one based on your environment.
l Select OK and press Enter to continue.

The Gateway Address page opens with the default gateway server IP address.

9. Do the following:

l Accept the default value or enter a new one based on your environment.
l Select OK and press Enter to continue.

A page opens showing a summary of your entries.

Configuring the Virtual Environment
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10. Review the information. Are the settings are correct?

l If yes, go to the next step.
l If no, go to step 13.

11. Press Enter. The system restart page opens.

12. Press Enter. The system restarts and implements the changes. On completion,
a login prompt appears.

13. Select No and press Enter. The Administrative IP Address page opens. Repeat
steps 5 through 10 to make any necessary changes. The system restart page
opens.

14. Press Enter. The system restarts and implements the changes. On completion,
a login prompt appears.

Configuring the Virtual Environment
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15. Press Ctrl + Alt to exit the console.
16. Go to Change the Default User Passwords next in this chapter.

Change the Default User Passwords
To ensure that your network is secure, you should change both the default
passwords of the sysadmin and root passwords on the virtual appliance.

Changing the sysadmin Password
To change the sysadmin password, complete the following steps:

1. At the login page, do the following:

a. Type sysadmin (case-sensitive), and then press Enter.

b. When the password prompt appears, type lan1cope, and then press
Enter.

2. On the System Configuration menu, select Password and press Enter.

Configuring the Virtual Environment
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Important: If you change the trusted hosts list from the defaults, youmust make sure
each Stealthwatch appliance is included in the trusted host list for every other
Stealthwatch appliance in your deployment. Otherwise, the appliances will not be able to
communicate with each other.

A prompt for the current password appears below the menu.

3. Type the current password, and then press Enter.

The prompt for a new password appears.

4. Type the new password, and then press Enter.

Notes:

l The passwordmust be between 5 and 30 alphanumeric characters in length with no
spaces. You alsomay use the following special characters: $.~!@#%_=?:,{}() Any
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password changemust be different from the previous password by at least four
characters.

l Any password changemust be different from the previous password by at least
four characters.

5. Type the new password again, and then press Enter. A message appears indic-
ating that the password was updated successfully.

6. Press Enter to return to the System Configuration Console menu.
7. Continue with the next section, “Changing the root Password.”

Changing the root Password
To change the root password, complete the following steps:

1. On the System Configuration Console menu, select Advanced, and then press
Enter. The Advanced menu opens.
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2. On the Advanced menu, select RootShell, and then press Enter.

A prompt for the root password appears.

3. Type the current root password, lan1cope, and then press Enter. The root shell
prompt appears.

4. Type SystemConfig (case-sensitive), and then press Enter.

This returns you to the System Configuration menu so that you can change
the root password.

5. Select Password, and then press Enter. The password prompt appears.
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6. Type the new root password, and then press Enter. A second prompt appears
below the menu.

7. Retype the new root password, and then press Enter.

A message appears indicating that the password was updated successfully.

8. When your password change is successful, type exit, and then press Enter. You
have now changed both of your default sysadmin and root passwords.

9. Press Ctrl+Alt to exit the console environment.
10. Continue with “Configuring a Virtual Appliance System.”

Configuring the Virtual Environment

© 2016Cisco Systems, Inc. AllRightsReserved.

37



l If yes, continue with “Configuring a Virtual Appliance System.”
l If no, return to “Configure the IP Addresses” on page 29 and repeat all of
the procedures in this chapter for the next virtual appliance. Then, go to the
“Configuring a Virtual Appliance System."
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4

CONFIGURING THE ENDPOINT
CONCENTRATOR VE
Overview

This chapter provides the procedures for configuring the Endpoint Concentrator to
begin processing traffic data. Once you have completed the steps in this chapter,
the installation and configuration process is complete.

Please refer to the checklist on “Before You Begin” on page 3 for the information
you will need before proceeding.

Process Overview
Configuring a virtual Stealthwatch involves completing the following procedures,
which we discuss in this chapter:

1. Configuring the Individual Appliances
2. Configuration through the Appliance Admin Interface

Configuring the Individual Appliances
Initial configuration of the Endpoint Concentrator VE is done with the Appliance
Setup Tool. The first time you access the appliance the Appliance Setup Tool is
displayed. Depending on your system, you should configure the FlowSensors and
Flow Collectors before the UDP Directors, and then, lastly, configure the SMC.
When you complete the initial setup for the SMC, the system setup tool opens and
you can configure your Stealthwatch System.

Before you begin, gather the information detailed in “Before You Begin” on page 3.

Note: Your screens may look slightly different from the ones presented here depending on
your environment.

To configure the Endpoint Concentrator VE, complete the following steps:
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1. In the address field of your browser, type https:// followed by the IP address of
the virtual the Endpoint Concentrator VE, and then press Enter.

2. The admin login page opens. Type admin and lan411cope (both case sensitive),
and then click Login. Go to step

5. The Welcome page opens. Click Continue.

The Management Network Interface page opens.
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6. Review the settings you previously entered, and then click Next. The Password
Management page opens

7. In the appropriate fields, type your new admin password, and then click Next.
The Host Name and Domain page opens,
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8. In the appropriate fields, type the host name and the network domain name,
and then click Next. The DNS Settings page opens.

9. Click the + button, and then type the IP address of the DNS server. Click Next.
The NTP Settings page opens.
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10. You can accept the default setting or enter another
server by entering the IP address of your NTP
server or selecting a name by clicking the list icon
and selecting one from the drop-down list.See "Con-
figuration through the Appliance Admin Interface"

11. Click Next. The Review page opens.
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12. Review your settings, and then click Apply. The confirmation dialogue opens.

13. Click OK. The Complete page opens.

14. Allow a few minutes for your new system settings to take effect and then click
Next.When finished, the login page for the appliance opens or the SMC landing
page opens.

15. Enter the login credentials if needed, and then click Login.

16. Continue with the next section, “Configuration through the Appliance Admin
Interface.”
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Configuration through the Appliance Admin
Interface

This section provides the following procedures to complete the configuration of a
virtual appliance using its Appliance Admin interface:

1. Log in to the Appliance Administration Interface
2. Configuring the Endpoint Concentrator VE
3. Configure the Endpoint Concentrator VE
4. Restart the Endpoint Concentrator VE

Log in to the Appliance Administration Interface
To log in to the Appliance Administration (Admin) interface, complete the
following steps:

Note: The supported browsers for Stealthwatch are Internet Explorer version 9 and later
and Firefox version 3 and later.

1. In the address field of your browser, type https:// followed by the IP address of
the virtual appliance, and then press Enter.

4. In the Username field, type admin.
5. In the Password field, type the admin password you created in the appliance

setup.

6. Click Login. The Appliance Admin interface Home page opens.
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Configure the System Time
To configure the Network Time Protocol (NTP) and system time (time zone)
settings on the virtual appliance, complete the following steps:

CAUTION! Use the sameNTP server used for the Flow Collectors and other devices that
feed information to the SMC.

1. On the Appliance Admin interface navigation pane, click the plus sign (+)
beside Configuration and then click System Time and NTP.

The NTP Server page opens showing the NTP server that you set in the
initial configuration using the Appliance Setup Tool.

Configuring the Endpoint Concentrator VE
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2. Scroll down to the Time Zone section of the page to configure the virtual appli-
ance system time.

3. Do the following:

l Select the Continent from the drop-down list.
l Select the Country from the drop-down list.
l Select the Timezone from the drop-down list.

The Apply notice appears.
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4. Click Apply to make the changes permanent. The confirmation window opens.

5. Click OK.

Configure the Endpoint Concentrator VE
For the Endpoint Concentrator VE you need to configure the connection to a
NetFlow Flow Collector from the Endpoint appliance. You can set only one Flow
Collector.

To configure the connection to the NetFlow Collector, complete the following steps:

1. In the navigation page, click the plus sign (+) beside Configuration, and then
click Collection.
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The NetFlow Collector page opens.

2. In the Assign NetFlow Collector fields, type the IP Address and the port num-
ber of the Flow Collector or UDP Director that you want the Endpoint Con-
centrator to send the data to. The default port is 2055.

3. Click Add. This will validate the IP address and port and move the entry to the
table.

4. If the information is correct, click Apply. This will restart the services with the
new information.
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Note: This field will only accept one value. If you need to add recipients, consider using a Cisco
UDP Director.

The NetFlow Collector settings appear in the table at the top of the page.

Note: If you need to change the setting for the Collector, first delete the current Collector by
clicking the Delete check box, and then clickingApply. Then you can configure a new
Collector.

5. In the main menu, click Home and check the Docker Services table:

6. Do all four have a status of “Running"?

a. If not, continue to the next section, Troubleshooting.

b. If yes, continue with the section, “Restart the Endpoint Concentrator VE”
on page 51.

Troubleshooting
After the AnyConnect Agents and the Endpoint Concentrator have been
configured, there are a few items that can be checked to determine if the system is
operational. These steps may be used if it is determined that the system is not
processing data as expected.

Configuring the Endpoint Concentrator VE

© 2016Cisco Systems, Inc. AllRightsReserved.
50



1. Validate that the Endpoint Concentrator is receiving flows from the AnyCon-
nect Agents to the Collector.

l Enable SSH access to the Endpoint Concentrator via the web admin page.
l Configuration -> Services – Check “Enable SSH”

2. SSH into the Endpoint Concentrator, run “docker ps”:

l Validate that there are four entries that contain kafka, netflow-parser, zoo-
keeper, and netflow-generator. Note that the Container IDs and Image ver-
sions will differ.

l If not they are not running, restart the Services from the appliance.

3. Change Directories to “/lancope/var/logs/containers” and run “tail –f net-

flow-parser.log”. Verify in the Stats print out that the counts are not zero.
4. Now, run “tail –f netflow-generator.log”. Verify in the Stats print out that

the counts are not zero. If the stats read as below, the Endpoint Concentrator is
not producing Netflow.

5. Validate AnyConnect Agents can send data to the Endpoint Concentrator.

l On one of the machines running the AnyConnect Agent, open a terminal or
command prompt and run “ping <IPofEndpointConcentrator>”.

l If there are response bytes, the Agent most likely can export to the Endpoint
Concentrator.

Restart the Endpoint Concentrator VE
To restart the virtual appliance, complete the following steps:

1. On the Appliance Admin interface menu, select Operations > Restart Appli-
ance.
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The confirmation dialog opens.

2. Click Yes.
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